
  



  

 
 
 
 
 
 

WARRANTY 
 
Hamar Laser Instruments, Inc., warrants each instrument and other articles of 
equipment manufactured by it to be free from defects in materials and 
workmanship under normal use and service, its obligation under this warranty 
being limited to making good at its factory any instrument and other article of 
equipment which shall, within one year after shipment of each instrument and 
other article of equipment to the original purchaser, be returned intact to Hamar 
with transportation prepaid, and which Hamar’s examination shall disclose to 
Hamar’s satisfaction to have been thus defective; other than this express 
warranty, Hamar neither assumes nor authorizes any other persons to assume for 
it any other liability or obligation in connection with the sale of its products. 
 
This warranty is not applicable to instruments or other articles of equipment 
manufactured by other companies and limited by a warranty extending for less 
than one year. In such an event, the more limited warranty applies to said 
instrument or article of equipment. 
 
This warranty shall not apply to any instrument or other article of equipment 
which shall have been repaired or altered outside the Hamar factory, or which has 
been subject to misuse, negligence, or use not in accord with instructions 
furnished by the manufacturer. 
 
The software described in this manual is furnished under a license agreement and 
may be used or copied only in accordance with the terms of the agreement.  It is 
against the law to copy the software on any medium for any purpose other than 
the purchaser's personal use. 
 
The information in this manual is subject to change without notice. No part of 
this manual may be reproduced by any means, electronic or mechanical, without 
written permission from Hamar Laser Instruments, Inc. 
 

© Copyright Hamar Laser Instruments, Incorporated, 2020 
5 Ye Olde Road, Danbury, Connecticut 06810 



  

 Table of Contents 
 

 
Hardware Overview .........................................................................................................................1 

Model L-706 Laser .......................................................................................................................1 
L-706 Operational Features .................................................................................................1 
Pulse/Continuous Modes .....................................................................................................1 
Adjusting the L-706 Laser ...................................................................................................2 

Model R-1307 Readout ................................................................................................................3 
R-1307 Control Panel ..........................................................................................................3 

The A-910 Radio Transceiver/Hub ..............................................................................................4 
Front Panel Features ............................................................................................................4 
Rear Panel Features..............................................................................................................4 

Configuring the R-1307 for a Cabled (Local) Target ......................................................................6 
Setting the Target Network ID and System ID for the R-1307 Readout .....................................8 

Miscellaneous Display Messages ........................................................................................8 
Using the Read10-2D Software .......................................................................................................9 

Installing the Read10-2D Software ..............................................................................................9 
Hamar Product Registration .........................................................................................................9 
Starting the Program ...................................................................................................................10 
Program Settings ........................................................................................................................10 

Units and Tolerances Tab ..................................................................................................10 
Display Settings Tab ..........................................................................................................11 
Communication Settings Tab .............................................................................................12 
Communication Tab - Advanced .......................................................................................12 
Other Options Tab..............................................................................................................13 

Target Display Boxes .................................................................................................................14 
Missing Data Warning Screen ...........................................................................................15 

Using the View Menu ................................................................................................................15 
Identifying Target Type Icons ...........................................................................................16 

Starting a New Project ...................................................................................................................17 
Viewing Recorded Data .............................................................................................................17 
Exporting Data to Excel .............................................................................................................18 

Appendix A - Agency Certifications .............................................................................................19 
Appendix B – R-1307 Battery Discharge Chart ............................................................................20 
Appendix C – Care and Cleaning of Target Optics .......................................................................21 
Appendix D – Using the Zigbee® Radio Utility ............................................................................22 

Pre-installing the Common USB Port Driver (A-910-2.4ZB) ...................................................22 
Installing the A-910 Utility Software .........................................................................................22 
Configuring the Hardware and Utility Settings ..........................................................................23 
Manually Selecting the COM Port .............................................................................................24 
Setting the Target System ID and Target Network ID ...............................................................25 

Setting the System ID ........................................................................................................25 
Setting the Target Network ID and System ID for the R-1307 Readout ...................................26 

Miscellaneous Display Messages ......................................................................................26 



 1  

Hardware Overview 
 
Model L-706 Laser  
 
The L-706 Laser has been designed with a .750 in. 
(19.05 mm) mounting stud and flat face with 
magnets to hold it flush to fixturing. Since the laser 
beam is concentric to the OD to within .0005 in. 
(0.01 mm), a simple flat face and .750 in. (19.05 
mm) hole on center is all that is needed to hold the 
laser. 
 
The L-706 has a range of 110 ft. (33 m), and under 
good environmental conditions, it is accurate to 
.001 in. (0.025 mm) over the whole range. The 
laser is powered by an AC adapter. 
 
L-706 Operational Features 
The following describes the operational features of 
the L-706 Laser. These features include bubble 
level vial orientation, micrometer values and 
settings, CONT/OFF/Pulse switches and the external battery pack.  
 
Pulse/Continuous Modes 
 
The L-706 Lasers are now equipped with a PULSE/CONTinuous switch, which manually switches the 
laser beam between Pulsed and Fixed Beam Modes. Pulse Mode automatically removes the effects of 
excess (ambient) background light for the R-1307 readouts, providing a more accurate reading. The R-
1307 Readout is capable of supporting both Pulse Mode and Continuous Mode as well as storing up to 
nine different target calibration factors for multiple target users. These capabilities must be specified 
when ordering a system. 
 
The chart below indicates the operational modes for Readouts/Computer Interfaces that operate with the 
L-706 Lasers:  

Mode Readouts Computer Interfaces 
Pulse R-1307B-2.4ZB, R-1307BC, R-1307C, R-

1307-900/2.4, R-1307-2.4ZB, R-1307+R 
A-910-900/2.4  

(when used with R-1307-900 or R-1307-2.4) 
A-910-2.4ZB 

CONTinuous R-307, R-307V R-358 
  
Notes:  
1. The T-261A and T-266 Targets do not support the Pulsed-Beam Mode and the system purchased is factory-

configured to operate in CONTinuous mode when using these targets.  
2. When using the L-700 Laser with the R-1307 and a 2-Axis Target, the system is factory-configured to operate in 

CONTinuous mode.    
The CONT/OFF/PULSE slide switch on the L-706 has a lighted LED to indicate that power is ON.  
CONTinuous:  The laser beam in continuous (Legacy) mode. This mode is compatible with all HLI 
interfaces. While in CONTinuous mode, there is limited background light noise suppression.  
PULSED: The laser beam blinks on and off at a rate of approximately 15 Hz. with background light 
noise suppression. This is the preferred mode of operation.  
 

Figure 1 – L-706 Laser 
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When configuring the R-1307 for use with a cabled (local) target, the descriptor selection 'P.10.10' is used 
for pulsed beam mode and 'F.10.10' is used for fixed beam mode. For a complete description of 
configuring a cabled (local) target for the R-1307 and the descriptor selections for both pulsed and fixed 
beam modes, see Page 6. 
 
Bubble level vials on the laser mounting flange are used for rotational accuracy. When the bubbles in the 
level vial are centered horizontally, all micrometer adjustments (controlling laser beam angle) shift the 
laser beam vertically or horizontally with reference to the bore/target axis. If the bubbles are not centered, 
any micrometer adjustment to one laser axis changes the laser beam position in both axes. The levels also 
provide fixture mounting repeatability (assuming the laser is hard-mounted to fixture).  
 
Micrometer controls are provided for the adjustment of the angle at which the laser beam emerges from 
the precision ground, mutually concentric steel laser housing. Each laser has a NOMINAL setting for 
both the V-Vertical and the H-Horizontal micrometer controls. The nominal settings are determined at the 
factory and correlate to values for the laser beam when it is perpendicular to both the 2 in. and 4 in. 
mounting faces. When the bubble in one of the level vials is centered, a nominal setting of each 
micrometer squares the laser beam to that specific axis. For example, if the nominal vertical setting is 
.120, then setting the micrometer to .120 sets the laser beam square to the vertical axis. When a laser is 
mounted in the gearbox or bore adapter, vertical and horizontal micrometers should be set in the nominal 
positions to facilitate the alignment and measurement process.  
 
Adjusting the L-706 Laser  
The L-706 Laser beam is factory adjusted to be concentric to the mounting diameters (2.25 in. or 57.15 
mm and .75 in. or 19.05 mm) within ±.0005 in. (0.0127 mm). With the adjusting micrometers set at the 
nominal position, (see the Nominal Settings label on the outer flange), the laser beam is perpendicular to 
the front mounting surface and parallel to the mounting diameters within ±.0003 in/ft. 
 
The circular level vial on the laser mounting flange is used to reference the orientation of the vertical and 
horizontal axes of the L-706 Laser. When the bubble in the level vial is centered, all micrometer 
adjustments (controlling laser beam angle) shift the laser beam vertically or horizontally with reference to 
the bore/target axis. If the circular level bubble is not centered, any micrometer adjustment to one laser 
axis makes the laser beam position appear to change in both axes. The level vial also provides fixture 
mounting repeatability (assuming the laser is hard mounted to the fixture). Only minor readjustments of 
the laser to the bore and fixture surfaces are required in situations where frequent alignment is expected. 
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Model R-1307 Readout 
 
The Model R-1307 Readout supports both wireless Unitargets, such as 
the A-1519, or cabled (local) targets. It is available with a radio 
frequency of either 900 MHz or 2.4 GHz ISM band. The R-1307 can be 
used as the primary readout or as an additional readout to copy position 
data captured by another R-1307.      
R-1307 Control Panel 
 
Figure 3 shows the features of the R-1307 Control Panel.  
 

 
 
 

 
 

 
 
Figure 3 -- R-1307 Readout Control Panel Features 

Figure 2 – R-1307 Readout 
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The A-910 Radio Transceiver/Hub 
 
Front Panel Features  
1. Power ON indicator and Low 

Battery indicator 
2. Internal backup battery charging 

indicator and USB LINK 
ESTABLISHED indicator 

3. TX indicator: blinks when device is 
transmitting data to the target(s) 

4. RX indicator: blinks when the 
device is receiving data from targets 
or other transceivers. 

5. System ID setting switch: set to the 
same number as the R-1307 CH 
(Channel) number. 

 
Rear Panel Features 
 
1. Not used 
2. USB/Data I/O Port 
3. Power Switch 
4. External power supply: required 

only for computers that cannot 
provide adequate power (5V, 400 
mA) through the USB port. 
Note: When using the USB Extender™ 
cable extension kit, plug the A-910-2.4 
into an A/C power supply. 

5. Antenna 
 
*See Appendix A for radio specification details. 
 

MODEL NUMBER PRIMARY FREQUENCY 

A-910-900 900 MHz 

A-910-2.4 2.4 GHz 

 

Figure 4 – The A-910 Radio Transceiver/Hub FRONT PANEL 

 
Figure 5 – The A-910 Radio Transceiver/Hub REAR PANEL 
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Figure 6 -- Settings Menu, Flow Diagram 
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Configuring the R-1307 for a Cabled (Local) Target 
 
 
 
 
 
 
 
 
 
Note: Shut off power to the readout before connecting or disconnecting a target from the local port.  
1. Connect the cabled target to the local port of the readout 
2. Press and hold the MENU button for approximately 2 seconds to enter configuration mode. 
3. Set the Measurement Units 

Press the MENU button until the upper display shows . Use the UP and DOWN arrow keys to 
selecting either  for inches or  for millimeters. 

4. Set the Dampening Level 
Press the MENU button until the upper display shows . Use the UP and DOWN arrow keys to 
set the number of averages. Adjust this value as required to suit the application. The default for this 
application should be changed to at least 8. For long distance shots, use 16 or 32.  

5. Set the Readout Function to Cabled (Local) Target 
Press the MENU button until the upper display shows . Use the UP and DOWN arrow keys to 
select  . 

6. Select the PSD (Position Sensing Device) descriptor applicable to your target 
Ensure that the Laser Mode switch is set to Pulse. 
Note:  If operating in Pulsed Beam Mode, select only the descriptors shown in bold type. The 
examples shown for Fixed Beam Mode are provided for compatibility with older (fixed beam) lasers 
only. 
Press the MENU button until the upper display shows , where  designates the target 
number.  
Each R-1307 can have up to 8 target (PSD) descriptors.  

• The upper display shows the target number ( 
• The lower display shows the PSD mode and size. 

For example: 
F.4.4 = Fixed Beam Mode. 4mm x 4 mm PSD 
P.4.4 = Pulsed Beam Mode. 4 mm x 4 mm PSD 
F.10.10 = Fixed Beam Mode. 10 mm x 10 mm PSD 
P.10.10 = Pulsed Beam Mode. 10 mm x 10 mm PSD 
F.20.20 = Fixed Beam Mode. 20 mm x 20 mm PSD 
P.20.20 = Pulsed Beam Mode. 20 mm x 20 mm PSD 
F.40.40 = Fixed Beam Mode. 40 mm x 40 mm PSD 
P.40.40 = Pulsed Beam Mode. 40 mm x 40 mm PSD  

nn= R-1307 Readout number and matching target number 
 

Press the UP or DOWN arrow keys to select the correct target number and to change the second 
window. For example,  .. or  .. for R-1307 #2 

 
WARNING: Targets are matched to specific R-1307 Readouts. For example, Target #1 must be 
connected to Readout #1 or the calibration is void. 

Previously, Hamar Laser offered only Fixed Beam Mode for the L-705, L-706 and L-708 lasers.  
We now offer lasers with Pulsed Beam Mode (in addition to Fixed Beam Mode) to increase 
accuracy and reduce the effects of background light errors on the measurement. To determine if 
your laser is capable of Pulsed Beam Mode, look at the power switch to see if Cont (Continuous) 
and Pulse are on either side of the switch. We strongly recommend that Pulsed Beam Mode be 
used whenever possible. 
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7. Select the device used for Relative (display zeroing) 

• Rel.0 = Local. R-1307 button(s) used to zero display. Use this mode for cabled targets or local 
zeroing with wireless targets. 

• Rel.0 = Target. Use this mode for the A-1519/A-1520 wireless targets with remote zeroing 
capability. Disables zeroing by the R-1307. 

8. To exit configuration mode, press and hold the MENU button for approximately three seconds 
until the display return to normal mode. 
The R-1307 will also return to normal mode automatically after approximately four seconds of 
inactivity.  
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Setting the Target Network ID and System ID for the R-1307 Readout 
 
To make the unit visible to all other radio-
enabled devices, you must set the Target 
Network ID and the System ID for the readout.  
1. Set the Local Readout/Target Network 

ID 
Press the MENU button until the upper 
display shows    (nn is also equal to 
the R-1307 number) and the matching 
Target number with the current Target ID 
() blinking. Use the UP and DOWN 
arrow keys to set the Target ID.   
Press the MENU button again until the 
lower display shows    with the 
current Target ID () blinking. Use the 
UP and DOWN arrow keys to set the 
Target ID to the same value as that of the 
upper display’s Target ID.   

2. Set the System ID (Radio Channel) 
Press the MENU button until the upper 
display shows   , with the current 
System ID () blinking. Use the UP and 
DOWN arrow keys to set the System ID. 
Note that nn must be set to the same 
number as the channel switch setting of the 
A-910 radio transceiver (see Figure 4, #5). 

 
Miscellaneous Display Messages 
  
 
  Startup Message.  Lower Display shows firmware Revision Number. 
. . . 3 moving dots. Wireless target is not responding to a polling request from Readout. 

Check ID and Channel settings. Check Target(s).  
    3 dashes.  Target detected but the laser is not on target. Check laser. 
 
  Radio channel cannot be selected because no Radio is present or detected.  

Standard message for R-1307C. For Models R-1307 or R-1307W, this message indicates 
a fault in the radio module.  

 
 Indicates a problem with the connection to the Cable (Local) Target’s Position Sensing 

Device (PSD). Check plugs and cable(s).             
   
  Target ‘’ descriptor does not contain target calibration data. 
 

Figure 7– R-1307 with Cabled (Local) Target and A-910 Radio 
Transceiver 
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Using the Read10-2D Software  
 
Installing the Read10-2D Software 
 
1. Unzip the program or insert the product CD. 
2. Open the folder where the extracted files are located. Double-click setup.exe. 
3. Follow the screen prompts to finish installation. 
 
Hamar Product Registration 
 
In order to protect against software pirat-
ing, we have implemented a simple prod-
uct registration procedure. After a Hamar 
product is installed and when the program 
is run for the first time, the user is prompt-
ed to enter the Product Registration Code 
(see Figure 8). To obtain the Product 
Registration Code, send the PC ID Code 
(automatically generated) displayed on the 
screen to Hamar Laser Support 
(Support@hamarlaser.com). A Hamar rep-
resentative will issue a Product Registra-
tion Code via email  to complete the regis-
tration process. Enter the Product 
Registration Code and click Register 
Product (see Figure 9). The product is now 
registered.  
 
 
 

 
 

 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
Figure 9 – Enter Product Registration Code 

Figure 8 —Product Registration Screen 

mailto:Support@hamarlaser.com
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Starting the Program  
Note: The A-910 must be powered up and connected using the USB cable prior to opening the Read10 
software so that the COM Port used can be detected. For a new installation, the Hamar Laser Common 
USB driver must be installed separately. Install this driver from the CD or download the driver from:  
http://hamarlaser.com/support-software 
 
To begin using the program, click the Windows START button and highlight PROGRAMS>HAMAR 
LASER INSTRUMENTS, INC. Click Read10-2D to run the program. When the program opens, it 
automatically searches for available COM Ports. When the A-910 is in use, the adapter driver usually 
assigns a higher number COM Port (for example, COM 4). If you are unsure of the correct COM Port, 
use the Windows Device Manager to check the port being used.   
Program Settings  
To change the settings, click Tools on the 
Action Bar and then select Options (see 
Figure 10). The Options menu allows 
you to change Units and Tolerances, 
Display Settings, Communication 
Settings and Other Options.   
Units and Tolerances Tab 
 
Select Units and Tolerances to change 
the following:  
Measurement / Display Units  

Changes the measurement units from 
millimeters, inches or microns. 
 
Resolution 
Changes the number of decimal places (for example, from .1 to 
.123). 
 
Deviation from Center-Allowable tolerance (±) 
Enables Measuring and Reference Target tolerance. 
Note: Both the Horizontal and Vertical axes need to be in tolerance 
for the numbers to turn green. 

 
 
 
 
 
 
 
 

Figure 11 – Units and Tolerances Settings 

Figure 10 – Selecting Program Options 
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Display Settings Tab  
Select Display Settings to change the following:  
Colors used in the target display boxes 
Click Invert Colors to swap the current colors (for example, changing a black background with white 
text to a white background with black text). Right click the background or left click the text color to 
change it by selecting the desired color from the palette (do not use the same color for text and 
background). 
 

 
Figure 12 – Changing color settings 
 
Changing Coordinates 
Check the Coordinates box to change V/H to Y/X.  
To close the application without saving changes, click 
Close.  
To apply and save changes, click Apply.  
To restore previous settings, click Cancel. 

 
 
 
 
 

 
 

 
 

 
 

Figure 13 – Changing Coordinates 
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Communication Settings Tab 
 
Note: Ensure that all R-1307 Readouts are powered on and the A-910 is plugged into the USB port 
before opening the Read10 software. 
 
Select the Communication Settings Tab to change the 
COM Port and R-1307 Polling Settings. The software 
allows only available COM ports to be selected. The green 
animated icon indicates that the software is communicating 
through the selected COM port. If data is received from any 
of the six targets (three measuring targets and three 
reference targets) or Readouts, the signal bars show the 
percentage of successful data transfers. Zero percent 
indicates that the A-910 is not receiving data from the R-
1307s. If all signal bars show 0 percent, try using another 
COM port.  
 
Signal Bars for Targets 1-4 show the communication 
efficiency rate (0-100%) 
• 0 % =  Target/R-1307 OFF or not detected because it is 

on another radio channel or out-of range of the A-910 
Transceiver.   

• Less than 50% = Sporadic communication. The targets or 
readouts are nearly out-of-range of the A-910 Transceiver or the radio signal is blocked by metal 
barriers.  

• Greater than 50% = Normal conditions in an environment that is saturated with other devices on the 
same frequency band (for example, Wi-Fi devices, Bluetooth devices, ZigBee devices, cordless 
phones, other HLI wireless systems, etc). This may also be caused by a high level of electrical noise 
often present in industrial environments.  

• Greater than 90% = Expected under ideal conditions 
 
Communication Tab - Advanced 
 
Radio Reply Timeout 
Other systems in the area that use Bluetooth, WiFi, etc. can interfere with the radio, causing the target to 
have a slower response. Changing the amount of radio reply time allows the radio a shorter or longer time 
to receive feedback from target. The minimum timeout is 150 milliseconds to maximum of 1000 
milliseconds.  
Off-Target Timeout 
This is the amount of time the software waits before it displays a blank screen in the specific Target 
display box. If the display box is blank, the software could not detect a target. The minimum timeout is 
800 milliseconds; the maximum is 10,000 milliseconds. 
 
Click on SET to DEFAULT to reset the timeouts to factory settings. 

Figure 14 – Communication Settings 
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Other Options Tab 
 
Disable ‘Record Data Point?’ Confirmation Dialog.  
If left unchecked, the user is not prompted to confirm the 
recording of a data point.  
Enable Software Averaging 
Adds software averaging (2 to 20 samples) in addition to 
the averaging that takes place within each R-1037 Readout 
connected to each target. 
Warning: A high number of samples slow the readout 
response, so use only if necessary. The preferred method is 
to allow the R-1307 do the averaging and disable 
averaging in the software. 
 
Set the Dampening Level for R-1307 
Press the MENU button until the upper display shows 
. For configuration information, see Configuring the 
R-1307 for a Cabled (Local) Target on Page 6.   
Auto Save Data 
The software automatically saves a project at the selected 
number of minutes. For example, entering 120 saves the 
project every two hours.    
Enable Additional sounds 
The software plays additional sounds while data is being 
recorded, when the communication port is opened or 
closed, and when a communication failure occurs. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 15 – Other Options 
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Target Display Boxes  
There are six Target Display Boxes. Each is 
continuously updated to show the latest target 
data. The top three boxes display data for the 
Measuring Targets and the bottom three 
boxes display data for the Reference Targets. 
In addition to displaying the target position 
readings, the following indicators may also 
display: 
 
 
 
 

Low Battery Indicator (red) displays when the battery level for the R-1307 is very low. The red 
indicator first displays when less than 13 percent (approximately 30 minutes) of battery life 
remains. 
  
Low Battery Indicator (yellow) displays when the battery level for the R-1307 is starting to get 
low. The yellow indicator first displays when less than 33 percent (approximately 2 hours) of 
battery life remains.  
 
 
Full Battery Indicator (green) displays when the battery for the R-1307 is fully charged. Place 
the cursor over the battery image to see the actual percentage of battery life remaining.  
 

 
 
Incident Light (white) indicates the ambient background light is normal.  
 
 
Incident Light (yellow) indicates the ambient background light needs to be reduced.  
 
 
 
Incident Light (red) indicates the ambient background light is near saturation and the 
readings may be affected.  
 

 
Zero Target Display: Click ABS to zero the target display. 
Note: Zeroing out the R-1307 does not zero the display in the Read10 software 
and vice-versa. 
 
 
 
Record Button: Click to record measurements. The display shows OFF TGT 
when the target is blocked or the laser beam is not hitting the target.  
 
 

 
Figure 16 – Target Display Boxes 
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Missing Data Warning Screen 
If a target is not reading and Record is pressed, a warning 
message displays. Click Abort to cancel record or correct 
the error condition and click Retry to try to record again. 
Click Ignore to record even though a target is not reading 
the Laser or the R-1307 is not responding. 
 
Using the View Menu 
 
Click View on the Action Bar to view a single Target Display 
box, all six display boxes, or Measuring or Reference Targets 
Display boxes (see Figure 17). Highlight the desired selection 
and click with the right mouse button or use the Ctrl+ key 
combinations. 
 
 
 
 

 
 

 
Figure 17 – The View Menu 

 

  
Figure 18 – Results of the View Menu, showing Measuring Target Readings (left) and Reference Target Readings (right)  
Each target display box shows the target number, 
the R-1307 serial number and an icon to identify 
the target type (PSD size), as shown in Figure 19.  
Clicking on either the Target Number or on the 
Target Type icon (see Figure 20 for all the Target 
Type icons) displays the Target/Device 
information, shown below. This information is 
specific to each target displayed.  

 
  
 
 
 
 
 
 

Figure 19 – Measurement Target Display Box showing 
R-1307 serial number, Target Number and Target Type 
(PSD Size) 
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Identifying Target Type Icons 
 
The Target Type icons identify the PSD size in millimeters (width x height). Note that this version of 
Read10-2D now supports 4x4 mm cells. All the icons except the middle icon represent 2-axis targets. The 
middle icon (10 x 30) represents a single-axis target, such as the A-1519.  

 
Figure 20 – Target Type icons 
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Starting a New Project 
 
To start a new project, click FILE>NEW PROJECT. Enter a name for 
the project, ensuring that the files type is saved as *.CSV (comma 
delimited) and begin taking measurements. Hit the spacebar to record or 
the REC button (if selected as an option). The Unable to Record Data 
message displays if there is no project currently open.  
 
To open a saved file, click FILE>EXISTING PROJECT. Select the 
project from the saved folder.  
 
Viewing Recorded Data 
 
To view recorded data, click FILE>DATA PREVIEW. You can add data to the report and all data from 
previous recordings remain.   
 
To add notes to a recording, right click on the line to edit, 
which displays the Table Editing Menu (see Figure 21).  
 
To Delete a Point: 
Select Delete Point to delete a data point from the database. 
This action cannot be undone. 
 
To Add Notes: 
Select Add Notes. Enter text in the box at the bottom of the display and click OK to apply the notes (see 
Figure 23). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 22  – Data Preview Screen 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 23– Data Preview screen showing added notes 

Figure 21 – The Table Editing Menu 
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Exporting Data to Excel 
 
To export data to a Microsoft Excel spreadsheet, click FILE>EXPORT TO EXCEL. Excel 
automatically opens and displays the report, showing any out of tolerance levels in red (see Figure 24). 
 

 
 

 
      

Figure 24– Readings shown in Excel spreadsheet 
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Appendix A - Agency Certifications 
 
Agency Certifications for the 2.4 GHz Radio Transceiver  

 
FCC (United States of America) Certification 
 

Contains FCC ID: OUR-24XSTREAM  
The enclosed device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference and (2) this device must accept any interference received, including 
interference that may cause undesired operation. 
 

 RF EXPOSURE WARNING: This equipment is approved only for mobile and base station transmitting 
devices, separation distances of (i) 20 centimeters or more for antennas with gains < 6 dBi or (ii) 2 meters or more for 
antennas with gains ≥ 6 dBi should be maintained between the antenna of this device and nearby persons during 
operation. To ensure compliance, operation at distances closer than this is not recommended 

 

IC (Industry Canada) Certification 
 

Contains Model 24XStream Radio (2.4 GHz), IC: 4214A 12008  
Complies with IC ICES-003 

 
 

 
 

Complies with ETSI.  France – France imposes restrictions on the 2.4 GHz band. Go to www.art-telecom.Fr or 
contact MaxStream♦ for more information. Norway – Norway prohibits operation near Ny-Alesund in Svalbard. More 
information can be found at the Norway Posts and Telecommunications site (www.npt.no). 
 
Since the 2.4 GHz band is not harmonized throughout Europe, other restrictions may apply to your country. 
 

Technical Data: 
• OEM radio transceiver, model number: 24XStream 
• Frequency Band: 2400.0 – 2483.5 MHz 
• Modulation: Frequency Shift Keying 
• Channel Spacing: 400 kHz 
• ITU Classification: 400KF1D 
• Output Power: 100 mW EIRP max. 
• Notified Body Number: 0891 

 
♦ The radio Transceiver contained in the A-1519/A-1520 Type II Universal Wireless Targets is manufactured by MaxStream. 
For more information pertaining exclusively to the Radio Transceiver please contact MaxStream at 1.801.765.9885 or visit their 
web site: http://www.maxstream.net 
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Appendix B – R-1307 Battery Discharge Chart 
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Appendix C – Care and Cleaning of Target Optics 
 
The proper care and cleaning of optical windows and/or lenses of Hamar Laser’s position-sensing devices 
(targets) assures optimum performance. Contaminants on an optical surface increase scatter, absorb laser 
energy, and eventually degrade the accuracy of the position-sensing devices. Because cleaning any 
precision optic risks damaging the surface, optics should only be cleaned when absolutely necessary. 
When cleaning is required, we recommend the following supplies and procedures.  
Required Supplies  
 Optics Cleaning Tissue: Soft, absorbent, lint-free lens tissue 
 Swabs: Cotton swabs with wooden handles or polyester swabs with polypropylene handles 
 Dust Blower: Filtered dry nitrogen blown through an antistatic nozzle is best. Canned dusters, such 

as Dust-Off, will also work.  
 Mild Soap solution: Neutral soap, 1 percent in distilled water. Avoid scented, alkali, or colored soap 

such as liquid dishwashing detergents or hand soap. Ten drops of green soap (available at a 
pharmacies and optical cleaning suppliers) per 100 cc of distilled water is an acceptable alternative. 

 Isopropyl Alcohol: Spectroscopic grade. Over-the-counter alcohol contains too much water and may 
have impurities. 

 Acetone: Spectroscopic grade. Do not use over-the-counter Acetone, such as the type intended for 
nail polish removal. 

 
NOTE: When cleaning precision optics, even with the best quality optical cleaning tissue, use gentle 
pressure to avoid scratching the surface or damaging the optical coating(s). Always wipe using a figure-
eight motion in one direction (begin at the top and work toward the bottom in a figure-eight motion). 
Use only moistened (not soaked) optical cleaning tissue, swabs and Spectroscopic grade Acetone and 
Isopropyl Alcohol. Never spray any type of liquid directly on the device or submerge any part of the 
device. 
 
Removing Dust  
Dust can bind to optics by static electricity. Blowing only removes some of the dirt. The remainder can be 
collected by using wet alcohol and Acetone swabs wrapped with optical lens tissue. Acetone dries rapidly 
and helps to eliminate streaks.   
1. Blow off dust. 
2. If any dust remains, twist lens tissue around a cotton swab moistened in alcohol and repeat as 

necessary. 
3. Repeat using Acetone.  
Cleaning Heavy Contamination  
Fingerprints, oil, or water spots should be cleaned immediately. Skin acids attack coatings and glass and 
can leave permanent stains. Cleaning with solvents alone tends to redistribute grime.    
1. Blow off dust.  
2. Using a soap-saturated lens tissue around a swab, wipe the optic gently. Repeat as necessary. 
3. Repeat using a distilled water-saturated lens tissue wrapped around a swab. 
4. Repeat using an alcohol-saturated lens tissue wrapped around a swab.  
5. Repeat using an acetone-saturated lens tissue wrapped around a swab. 
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Appendix D – Using the Zigbee® Radio Utility 
 
Pre-installing the Common USB Port Driver (A-910-2.4ZB) 
 
This driver is required for the A-910-2.4ZB Transceiver and to communicate with targets via the 
computer’s USB port. The driver creates a virtual COM Port that is recognized by the applications as a 
standard serial port. 
 
Note: You must pre-install this driver prior to connecting the device(s) to the computer through the USB 
port.  
 
Installing the Driver  
1. Insert the A-910-2.4ZB Radio Programmer CD in the CD ROM drive. 
2. Select My Computer, locate the CD ROM icon and click to open it.  
3. Select the USB Drivers folder. 
4. Select the correct Operating System installed on your computer (Windows 2000, Windows XP, etc.) 

and open the folder. 
5. Locate the CP210x_VCP icon and click to initiate the installation process. The Install Driver 

dialog box displays. 
6. Click Browse to select an installation folder different from the default folder (optional). 
7. Click Install to continue. Once the installation is complete, the Installation Successful message 

displays (see Figure 25). 
 

 
 
Figure 25 - USB Common Driver Install 
 
Installing the A-910 Utility Software 
 
1. Insert the A-910-2.4ZB Radio Programmer CD in the CD ROM drive. 
2. Select My Computer, locate the CD ROM icon and click to open it. 
3. Locate the Setup icon and click to initiate the installation process.  Click NEXT to continue. 
4. Click Browse to select an installation folder different from the default folder (optional).  
5. Click Next to continue. Once the installation is complete, the Installation Complete message 

displays. Select Close. 
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Configuring the Hardware and Utility Settings 
 
1. Insert the A-910 ZB dongle into any unused USB Port (see Figure 26). 

The computer should automatically assign a COM port number to the 
dongle.  

 
2. Start the A-910 Utility Software. The software should display the COM 

port assigned to the Zigbee Dongle (see Figure 27). If the utility does 
not automatically detect the COM port, it must be manually selected (see Manually Selecting a 
COM Port on Page 24). 

 
3. The Target System ID or R-1307 CH (channel) is the number associated with the A-1519/1520 

targets or R-1307 Readout. If using both the A-
1519/1520 targets and an R-1307 Readout, both 
need to be set to the same system ID and channel 
(see Figure 28).  

 
  

 
 
 
 
 

 
Figure 27 – A-910 Utility showing the COM Port, System ID and Channel settings 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 28 – System ID Setup 

Figure 26 – A-910 Zigbee Dongle 
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Manually Selecting the COM Port 
 
The A-910 Utility should automatically detect the COM 
Port upon startup. If not, use the following steps to locate 
the correct COM Port. 
 
Windows XP 
 
1. Right-click My Computer.  
2. Click Properties and then select the Hardware tab.  
3. Click Device Manager. 
 
Windows 7 
 
1. Click the Start button and select Control Panel. 
2. Click the System icon. 
3. In the System window, click on the Device Manager 

link located under the System heading. 
4. In Device Manager, scroll down to Ports. Expand the 

listings under Ports to reveal all the ports installed.  
5. Locate SILICON LABS CP210x USB to UART 

Bridge (COM x) (see Figure 29). 
6. Note the COM Port listed and select that COM Port 

in the A-910 Zigbee Utility software using the drop-
down arrow (see Figure 27).  

 

Figure 29 – Device Manager showing COM Port for A-910 
Dongle 
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Setting the Target System ID and Target Network ID 
 
The System ID is a Radio Network Address that is used by the Radio Communications Protocol to filter 
unwanted data from other radio transceivers and targets using a different address. Only targets and radio 
transceivers that are set to a matching System ID can communicate with each other. 
 
Because no two targets with the same System ID can transmit simultaneously, it is necessary for each 
target to be programmed to respond only when it is being addressed. The Target Network ID is the target 
address on the communications network. Under Host (computer) control, the radio transceiver transmits a 
message called a polling request that contains the Target Network ID of one specific target. All targets 
receive all polling requests, but only the target with a Network ID matching the ID contained in the 
polling message will reply (Transmit Data to the Host). 
 
There are three rotary DIP switches located on the 
right side of the target, shown in Figure 30: 
 

• The uppermost switch sets the System ID. 
• The two lower switches are used to set the 

target network ID. 
 
Setting the System ID 
 
Note: Before selecting a System ID, ensure that it is 
not already in use by another system within the radio 
coverage area. 
 
Using a small screwdriver, rotate Switch 1 to align 
the arrowhead with the System ID number (0-9). 
Figure 30 shows the System ID switch set to 1. 
 
 
 
 
 

Figure 30 – Unitarget ID Switch set to1 
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Setting the Target Network ID and System ID for the R-1307 Readout 
 
To make the unit visible to all other radio-
enabled devices, you must set the Target 
Network ID and the System ID for the readout.  
3. Set the Local Readout/Target Network ID 

Press the MENU button until the upper 
display shows  (nn is also equal to 
the R-1307 number) and the matching target 
number with the current target ID  () 
blinking. Use the UP and DOWN arrow keys 
to set the Target ID.    
Press the MENU button again until the lower 
display shows , with the current target 
ID () blinking. Use the UP and DOWN 
arrow keys to set the Target ID to the same 
value as that of the upper display’s Target 
ID.  

 
4. Set the System ID (Radio Channel) 

Press the MENU button until the upper 
display shows   , with the current 
System ID () blinking. Use the UP and 
DOWN arrow keys to set the System ID. 
Note that nn must be set to the same number 
as the channel switch setting of the A-910 
radio transceiver (see Figure 31). 

 
Miscellaneous Display Messages 
  
 
  Startup Message.  Lower Display shows firmware Revision Number. 
. . . 3 moving dots. Wireless target is not responding to a polling request from Readout. 

Check ID and Channel settings. Check Target(s).  
    3 dashes.  Target detected but the laser is not on target. Check laser. 
 
  Radio channel cannot be selected because no Radio is present or detected.  

Standard message for R-1307C. For Models R-1307 or R-1307W, this message indicates 
a fault in the radio module.  

 
 Indicates a problem with the connection to the Cabled (Local) Target’s Position Sensing 

Device (PSD). Check plugs and cable(s).             
   
  Target ‘’ descriptor does not contain target calibration data. 
 

Figure 31– R-1307 with Cabled (Local) Target and A-910 Radio 
Transceiver 
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